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1. Introducción y Objetivos

Se introducen 5 herramientas de computación matemática que se consideran muy importantes en la

formación de un alumno con cierta orientación matemática y en general científica: las

calculadoras, las hojas de cálculo, los programas de cálculo, la mejor forma de escribir

matemáticas y LaTeX.

Además de los mejores programas comerciales, se ha puesto especial interés en destacar

programas gratuitos con licencia pública general de GNU o similares. También se ha querido

destacar aplicaciones web que permiten trabajar desde cualquier ordenador conectado a Internet

sin instalar ningún software salvo el navegador. Además de ser aplicaciones que funcionan muy

bien, ofrecen la posibilidad de colaborar entre varias personas. En un ambiente de enseñanza la

colaboración entre alumnos y con el profesor es algo que se debe fomentar.

En general es una buena estrategia utilizar herramientas adecuadas para los problemas que nos

encontramos. Es claro que utilizar una herramienta demasiado simple nos limita mucho, pero

utilizar una herramienta demasiado potente puede producir un gasto de tiempo enorme para

aprender cómo funciona esa herramienta (especialmente si no se va a utilizar en un futuro). Por

esta razón tratamos herramientas que cubren todo el rango, desde las más básicas (una calculadora

para hacer cálculos, o texto simple para escribir fórmulas) hasta las más potentes (Mathematica

para hacer cálculos, o LaTeX para escribir fórmulas).

Las hojas de cálculo son una herramienta tan versátil que con mucha probabilidad una persona se

encontrará en algún momento de su vida con una situación en la que una hoja de cálculo puede

ahorrarle mucho tiempo e incluso dinero. En un entorno científico, estas probabilidades aumentan

si cabe. Por tanto, adquirir unas nociones de nivel intermedio es muy aconsejable (para cuando

sean necesarias).

En cada herramienta o software o truco se ha puesto una valoración subjetiva de lo fácil o difícil

que es manejarlo:

* muy fácil

** fácil pero requiere algo de tiempo/esfuerzo

*** requiere bastante tiempo/esfuerzo

**** requiere mucho tiempo o es una herramienta muy especializada

Objetivos
1) Saber qué tipos de calculadoras existen y cuál es el más apropiado para estudiar matemáticas.

2) Conocer las principales hojas de cálculo y manejar sus funcionalidades más prácticas.

3) Conocer los principales programas de cálculo simbólico, numérico y estadístico.

4) Conocer cuál es la mejor forma de escribir matemáticas en diferentes entornos: texto, HTML o

Word.

5) Saber qué es LaTeX, cómo instalarlo y empezar a utilizarlo.
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2. Prueba de Autodiagnóstico

Lea las preguntas planteadas, y si no sabe responderlas, o no está seguro, es aconsejable que lea la

ficha indicada.

1) Si tecleamos “2+1*3=” en una calculadora básica (no más de 25-30 teclas) y después lo

tecleamos en una calculadora científica (con más de 40 teclas), ¿sale lo mismo?

(Ficha 1)

2) ¿Qué programa gratuito, tipo hoja de cálculo, se puede utilizar en un PC?

(Ficha 2)

3) ¿Qué es una aplicación web?

(Ficha 2)

4) ¿Cómo se escribe un rango de celdas en una fórmula de una hoja de cálculo?

(Ficha 2)

5) ¿Cómo se agrega una línea de tendencia en un gráfico de una hoja de cálculo como

Microsoft Excel?

(Ficha 2)

6) ¿Cuál es la diferencia entre una calculadora y un programa de cálculo simbólico?

(Ficha 3)

7) ¿Cómo escribiría una letra griega en un entorno que admite HTML?

(Ficha 4)

8) ¿Sabe insertar una fórmula en Microsoft Word 2003 o 2007?

(Ficha 4)

9) ¿Qué es LaTeX?

(Ficha 5)

10) ¿Sabe instalar LaTeX?

(Ficha 5)
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3. Contenidos

Ficha 1: Calculadoras
Cualquier programa de cálculo para ordenador hace mucho más que cualquier calculadora, sin

embargo las calculadoras son eficientes y efectivas en lo que hacen. Para muchos problemas de

matemáticas una calculadora científica o gráfica/programable es suficiente, por eso todavía son

herramientas que se utilizan.

Calculadora programable/gráfica ** Calculadora científica ** Calculadora básica *

Teclas Además de las teclas numéricas 0-9 y de las teclas de operaciones básicas

(unas 20-25 teclas), tiene otro grupo de teclas con funciones avanzadas (25-30

teclas). Además cada tecla tiene al menos 3 funciones: la función escrita en

blanco sobre la tecla, la función en naranja/amarillo que se accede a ella

utilizando la tecla SHIFT, y la función roja que se accede a ella con la tecla

ALPHA.

Además de las teclas numéricas 0-9, el

punto decimal y el igual, también tiene las

4 operaciones básicas, la raíz cuadrada, el

cambio de signo, la tecla de porcentaje, el

borrado parcial y completo, y las 3 teclas

de memoria.

Ventajas  Es posible hacer gráficas,
 programas sencillos,
 guardar texto,
 hacer cálculos multilínea.

 Son relativamente
baratas,

 se admiten en
exámenes de la UNED.

 Son fáciles de aprender
a manejarlas y no se
olvida como utilizarlas.

 Muy baratas
 Su utilización en muy sencilla
 Se admiten en exámenes

aunque no tienen mucha
utilidad.

 Son útiles para cálculos diarios.

Des-

ventajas

 Son caras
 NO se admiten en exámenes
 Requiere un poco de esfuerzo

aprender a utilizarlas y se
olvida rápidamente.

 Un ordenador con el software
apropiado hace todo y más
que lo que hace una
calculadora de este tipo.

 Un ordenador con el

software apropiado

hace todo y más que lo

que hace una

calculadora de este

tipo.

 Si tecleamos “2+1*3=”
obtenemos 9 = (2+1)*3. Es
decir, no entiende la prioridad
de los operadores (primero se
efectúan las multiplicaciones y
después las sumas).

 Cualquier móvil tiene la
aplicación de calculadora
básica, por tanto comprarse una
es prácticamente innecesario.



Roberto Canogar McKenzie Curso 0 Matemáticas

6

Ficha 2: Hojas de Cálculo

Una herramienta que está demostrando ser más y más útil en variedad de situaciones son las hojas

de cálculo. Una hoja de cálculo es una tabla de celdas, en cada celda puede haber típicamente un

número, un texto o una fórmula que tiene en cuenta el contenido de otras celdas.

Las hojas de cálculo principales son:

I. Microsoft Excel ** (Windows y Mac). Las dos versiones que más se utilizan son Excel

2003 y Excel 2007.

La diferencia principal entre Excel 2003 y 2007 es la distribución de botones y los menús.

El aspecto visual y la forma de encontrar las cosas ha cambiado mucho. En mi opinión, la

última versión del programa es más intuitiva y más atractiva. Además los ficheros de

Excel 2007 se graban con extensión .xlsx y no son compatibles con Excel 2003.

Ante la pregunto de si ¿merece la pena cambiarse de Excel 2003 a 2007? Mi respuesta es

que si uno sigue queriendo trabajar con Excel, a pesar de las alternativas gratuitas, y el

coste de pasar de una versión a otra es asumible, mi opinión es definitivamente que sí. Y

mi opinión es la misma para el resto de programas de Office que conozco: Word, Power-

Point y Outlook.

II. OpenOffice Calc ** (Windows y Linux) que es gratuito. Es la versión gratuita de

StarOffice , el cual ofrece opciones avanzadas. Es compatible con los ficheros de

Microsoft Office.

III. Numbers ** (Mac). Su

primera versión data de

mediados de 2007 (fecha en

el que se lanzó iWork

2008), pero aún así es un

programa robusto y

amigable. Destaca en el

aspecto visual de la interfaz

y los gráficos que produce.

IV. Editgrid.com **(aplicación

web, por tanto cualquier

Sistema Operativo). Una

aplicación web es un

programa que se ejecuta a

través de un navegador de

internet. El caso más

extendido es sustituir una

aplicación de correo

electrónico como Outlook o
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Thunderbird por el gestor de correo web que incluyen cuentas como Gmail o Hotmail. La

ventaja de tener una cuenta de Gmail o Hotmail es que desde cualquier ordenador (que

tenga navegador e internet) se puede acceder y gestionar el correo igual que en casa.

En el caso de las

aplicaciones de Microsoft Office o OpenOffice existen sustitutos que funcionan muy bien.

Para hojas de cálculo, existen actualmente 3 aplicaciones web competidoras importantes:

Editgrid, Google Spreadsheets (parte de Google Docs) y Zoho Sheet. Editgrid está

especializado en hojas de cálculo, mientras que Google Docs y Zoho también ofrecen

sustitutos a Word y PowerPoint. Es gratis utilizar estas aplicaciones web, únicamente hay

que registrarse, aunque para tener acceso a ciertas características muy avanzadas hay que

pagar. En todo caso, para la mayoría de usuarios la versión gratuita es suficiente.

La ventaja de tener una hoja de cálculo guardada en internet y accesible desde cualquier

ordenador, además de la comodidad de poder acceder a ellas desde cualquier ordenador, es

el uso colaborativo que se le puede dar. Varios usuarios pueden ver y editar en tiempo

real los datos de la hoja de cálculo. Se puede crear la hoja de cero, pero también se puede

cargar desde un fichero Excel, OpenOffice, Lotus, Gnumeric o CSV. Una vez creado se

puede exportar a muchos formatos, e incluso se puede incrustar parte o la totalidad de la

hoja en otras páginas webs o blogs. También es posible insertar funciones que reciben

datos en tiempo real de tipo meteorológico, financiero, etc. Como una hoja de cálculo es

muy flexible, la opción colaborativa puede hacerla útil en muchas situaciones.

Las desventajas de una aplicación web tipo Editgrid es que es más lenta y tiene menos

opciones. En general, las opciones básicas e intermedias están todas, pero las opciones

avanzadas (por ejemplo, tablas dinámicas o macros no suelen estar incluidas, aunque Zoho

Sheets sí incluye ambas) y las opciones que dan al documento un aspecto más vistoso

suelen faltar.

A continuación no quiero hacer una introducción completa a las hojas de cálculo, sino más bien

asumir que el usuario sabe crear, grabar y abrir una hoja de cálculo y poner números en las celdas,

y destacar funcionalidades de nivel medio que hacen las hojas de cálculo sean una herramienta

muy potente. Todo esto funciona en cualquiera de los programas anteriores aunque con pequeñas

variaciones: principalmente, el nombre de las funciones puede cambiar dependiendo del idioma y

del programa utilizado, y además también puede cambiar la forma de insertar los gráficos y sus

opciones (los ejemplos detallados a continuación se han hecho con Excel 2007 en Español).

 Hacer progresiones *. Supongamos que queremos celdas

en una misma columna con los números 2,4,6, etc.

Entonces sólo hace falta escribir dos celdas con los

números 2 y 4, seleccionarlas, poner el cursor en la esquina

inferior derecha hasta que aparezca una cruz, hacer click

(botón izquierdo) con el ratón y por último arrastrar el

cursor hacia abajo para que aparezcan los números 6, 8, etc.

Al soltar el botón del ratón aparecerán los números.
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 Fórmulas sencillas *. En la mayoría de las fórmulas

hay que utilizar un rango de celdas. Por ejemplo,

supongamos que queremos sumar desde la celda B2

hasta la celda B6 y poner el resultado en la celda B8.

Entonces hay que pinchar con el ratón en la celda B8

y escribir “=SUMA(B2:B6)”. El “=” se pone para

indicar que hay que hacer algún calculo antes de

mostrarlo en la celda, ya que si se escribe

“SUMA(B2:B6)”, se mostrará ese texto en la celda. SUMA es la función que suma varias

celdas, y B2:B6 indica el rango desde la celda B2 hasta la celda B6. Al presionar Enter en

la celda B8 aparecerá el resultado. Nótese que también se pueden hacer rangos de celdas

en horizontal: “B2:E2” indica el grupo de celdas B2,C2,D2,E2.

 Copiar fórmulas *. Supongamos que en la celda B8 hemos introducido la fórmula para

sumar desde la celda B2 a la B6 y queremos hacer lo análogo para la columna C y D (es

decir, sumar desde la celda C2 a la C6 y ponerlo en la celda C8 y sumar desde la celda D2

a la D6 y ponerlo en la D8). Entonces, hacemos lo mismo que en el caso de progresiones:

seleccionamos la celda B8, ponemos el cursor en la esquina inferior derecha hasta que

aparezca una cruz, hacemos click y por último arrastramos el cursor hacia la derecha para

extender la fórmula a esas celdas. Es como si Excel adivinase la fórmula que queremos.

Ésta es una funcionalidad muy práctica.

También se pueden copiar fórmulas a una celda cualquiera con copiar y pegar (Ctrl+C,

Ctrl+V). Por ejemplo, si copiamos la fórmula de B8 ( “=SUMA(B2:B8)” ) a la celda A10

entonces la fórmula que aparecerá en A10 será “=SUMA(A4:A8)”. Es práctico pensar en

que si en la celda B8 ponemos la fórmula “=SUMA(B2:B6)” entonces B2:B6 son

referencias relativas a B8, o es como decir ‘suma las celdas desde la que está 6 celdas

por encima (B2) hasta la que está 2 celdas por encima (B6)’. Al copiar la fórmula, el rango

cambia porque son referencias relativas.

 Referencias absolutas **. A veces es útil que las referencias que se hacen en una fórmula

sean referencias absolutas, es decir, referencias que al copiar y pegar no cambian. Para que

las referecia sean absolutas se utiliza el símbolo $ de esta forma “=SUMA($B$2:$B$6)”.

Si hubiésemos escrito esto en B8 e intentamos trasladar esta fórmula a C8 y D8 como en el

apartado anterior, seguiríamos obteniendo el mismo resultado 15.
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 Ejemplo de una regresión lineal o aproximación lineal **. Un ejemplo que aparece muy

a menudo consiste en que medimos la posición de un objeto en movimiento a ciertos

intervalos de tiempo y queremos encontrar una fórmula que relacione el tiempo con la

posción. La forma más común para hacer esto es la regresión lineal por mínimos

cuadrados. Como ejemplo, supongamos que para los tiempos 5, 10 y 14 las posiciones son

15, 30 y 60 respectivamente. Estos datos son los que están localizados en la última figura

en las celdas B6,C6,D6 para el tiempo (como rango se puede escribir B6:D6) y B8,C8,D8

para la posición (B8:D8). Ahora queremos econtrar una fórmula del estilo

“Posicion=m*Tiempo+b” con m y b fijos y dónde las observaciones que hemos hecho se

ajusten lo mejor posible (respecto a una medida que se llama de los mínimos cuadrados) a

esta fórmula. El parámetro m se suele llamar pendiente y b se suele llamar interección con

el eje. Pues bien, hay dos fórmulas en Excel que se llaman PENDIENTE e

INTERSECCION.EJE que calculan estos valores, además hay otra fórmula que se llama

COEFICIENTE.R2 que calcula cómo de buena es la aproximación lineal a los valores

observados. Para calcular la pendiente escribimos la fórmula “=PENDIENTE($B$8:$D$8;

$B$6:$D$6)” en la celda F6 o cualquier otra, da igual. La razón de utilizar referencias

absolutas (utilizando $) es que ahora podemos copiar el contenido de la celda F6 a las

celdas F7 y F8, para después cambiar en F7 la función PENDIENTE por

INTERSECCION.EJE y cambiar en F8 la función PENDIENTE por COEFICIENTE.R2.

Éste sería un caso en que las referecencias absolutas son muy útiles, porque nos permiten

reutilizar los rangos (que siempre son liosos de introducir). En el ejemplo hemos

introducido en las celdas E6,E7,E8 un texto para identificar las cifras.

 Gráficos ***. Como ejemplo vamos a poner los datos anteriores en un gráfico de

dispersión (es decir un gráfico con puntos) y vamos a escribir la recta que mejor aproxima

los datos (que hemos obtenido en el apartado anterior). Primero tenemos que seleccionar

las celdas donde están los datos, para ello con el ratón hacemos click (botón izquierdo) en

la celda B6 sin soltar el botón izquierdo y arrastramos el ratón a la derecha para que

queden seleccionadas las celdas B6,C6,D6 y después soltamos el botón izquierdo del

ratón. Después pulsamos la tecla Control (la abreviaremos como Ctrl) y volvemos a pulsar

el botón izquierdo del ratón pero ahora sobre la celda B8 y arrastramos el ratón a la

derecha para que queden seleccionadas las celdas B8,C8,D8. Finalmente al soltar el botón

izquierdo del ratón y la tecla Ctrl, quedarán seleccionadas las 6 celdas que nos interesan

B6,C6,D6 y B8,C8,D8. Saber seleccionar conjuntos de celdas es importante y aunque

pueda parecer un tanto difícil si no se ha hecho nunca, con un poco de práctica se vuelve

algo muy intuitivo.

Para insertar el gráfico utilizando estas celdas seleccionadas, vamos a la pestaña Insertar
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(en Excel 2007) y apretamos en el botón Dispersión y debería aparecer el gráfico

siguiente. Para añadir al gráfico la recta y su ecuación debemos poner el puntero sobre uno

de los puntos del gráfico y apretar al botón derecho del ratón, entonces aparecerá un menú

de contexto dónde una de las opciones es “agregar línea de tendencia…”. Al seleccionar

esta opción aparecerá una ventana titulada “Formato de línea de tendencia” y dónde

debemos seleccionar las opciones “Presentar ecuación en el gráfico“ y “Presentar el valor

R cuadrado en el gráfico”. Al Cerrar esta ventana se verá la línea de tendencia junto con la

ecuación de la recta y R2.
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Ficha 3: Programas de Cálculo Simbólico, Numérico y Estadístico

Un programa de cálculo es un programa de ordenador que extiende las funcionalidades de una

calculadora. Existen varios tipos de programas de cálculo:

La principal diferencia entre un programa de cálculo simbólico y una calculadora tradicional es

la habilidad del primero para trabajar con ecuaciones y fórmulas simbólicamente, en lugar de

numéricamente. Es decir, una expresión como a + b es interpretada siempre como "la suma de dos

variables", y no como "la suma de dos números" (con valores asignados). Un programa de cálculo

simbólico nos permite automatizar manipulaciones tediosas o difíciles como, por ejemplo,

desarrollar la expresión (x − 10)500.

Un programa de cálculo numérico no ofrece la opción de hacer cálculos simbólicos avanzados

(aunque sí básicos) pero puede trabajar con números enormes y con una precisión altísima, de

forma rápida y eficiente.

Finalmente los programas estadísticos están preparados para analizar grandes cantidades de datos

y aplicarles multitud de técnicas estadísticas. Especialmente adecuados para hacer “data mining” o

minería de datos. Bajo el nombre de minería de datos se engloba todo un conjunto de técnicas

encaminadas a la extracción de conocimiento procesable, implícito en las bases de datos. Para un

experto, o para el responsable de un sistema, normalmente no son los datos en sí lo más relevante,

sino la información que se encierra en sus relaciones, fluctuaciones y dependencias.

Los mejores programas de cálculo son:

Programas comerciales y sus características

I. Mathematica *** (Windows, Mac y Linux). Probablemente el programa de cálculo

simbólico más potente, y el mejor considerado en Universidades de todo el mundo. La

desventaja es que tiene un precio muy alto. Tiene una ayuda excelente, eso hace que

aprender a manejarlo sea manejable y no haga falta utilizar ningún libro (de ahí las 3

estrellas). http://www.wolfram.com/products/mathematica/index.html

II. Maple **** (Windows, Mac y Linux) es la competencia más directa de Mathematica

como programa de cálculo simbólico. Es más barato, aunque es algo menos intuitivo y no

es tan innovador como Mathematica. http://www.maplesoft.com/

III. MatLab **** (Windows, Mac y Linux) es el programa de cálculo numérico (aunque

puede utilizar la máquina de cálculo de Maple para funcionar como un programa de

cálculo simbólico), y es especialmente potente en la manipulación de matrices y

algoritmos de cálculo numérico. En el ámbito de las Ingenierías suele preferirse a los dos

programas anteriores. http://www.mathworks.com/products/matlab/

IV. SPSS **** (Windows, Mac y Linux) es un programa para análisis estadísticos. Los hay

más potentes, pero por la relación de calidad/precio es probablemente el más extendido.

http://www.spss.com/software/
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V. Origin **** (Windows y Mac) es un programa muy potente especializado en analizar

datos y hacer gráficos de todo tipo. Para más información ir a http://www.originlab.com/ .

Programas gratuitos

I. Maxima *** (Windows, Mac y Linux) es un programa de cálculo simbólico gratuito de

licencia GNU. Entre los programas de cálculo simbólico gratuitos es probablemente el más

amigable y a la vez potente.

Para instalar en Windows hay que ir a http://maxima.sourceforge.net/es/, en esta página

hay un vínculo que pone Administrador de archivos de SourceForge. En la nueva página

hay un apartado “File Releases“ donde actualmente podremos ver una pestaña desplegada

con el título “Latest 5.15.0-Windows” y dentro de esta pestaña veremos el archivo

“maxima-5.15.0.exe” (que tiene unos 21Mb) que es dónde tenemos que pinchar (botón

izquierdo) para descargar el archivo. En el caso de querer instalar la versión Linux habrá

que desplegar el apartado 5.15.0-Linux y en el caso de querer instalarlo en un Mac hay que

ir a 5.15.0-source.

La instalación en Windows (dura menos de un minuto) se hace ejecutando el archivo

maxima-5.15.0.exe, eligiendo el idioma (existe en español), aceptando la licencia gratuita

y dando a

Continuar en todas

las ventanas. En el

escritorio quedará

el icono de

wxMaxima (que es

un entorno gráfico

de Maxima) para

ejecutar Maxima.

En la carpeta de

programas existe

xMaxima que es

una versión menos

amigable que

wxMaxima.

Las operaciones se

ponen en la caja

que aparece abajo

con el nombre

“ENTRADA: “. Es

importante recordar que cualquier entrada en esta caja debe acabar con “;” (es el

equivalente del “=” en las calculadoras). Además de ser una calculadora excelente (se

puede probar introduciendo cosas como “5*(8^3-1)^2+7! ;” ), también es capaz de hacer

gráficas: probar con “wxplot2d([x^5-2*x^3+x, x, x^2 ], [x,-1,1]);” que indica que

represente las funciones f(x)= x5-2x3+x , f(x)=x, f(x)=x2, para x en el intervalo [-1,1]. Es

interesante comentar que los gráficos en Maxima se hacen utilizando el programa
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GNUplot, que se puede instalar como programa aparte para hacer gráficas. Para aprender

los comandos se recomienda ir a la Ayuda de Maxima (F1).

II. GNU Octave **** (Windows, Mac y Linux) es el equivalente gratuito de MatLab (es

decir, un programa de cálculo numérico). http://www.gnu.org/software/octave/ .

III. PSPP **** (Windows, Mac y Linux) y R ****(Windows, Mac y Linux) son los

equivalentes gratuitos de SPSS (es decir, programas para análisis estadísticos). Para

encontrar información sobre los dos programas y cómo instalarlos ir a las URLs

http://www.gnu.org/software/pspp/ y http://www.r-project.org/ respectivamente.

IV. QtiPlot **** (Windows, Mac y Linux) es el equivalente gratuito de Origin (es decir, un

programa especializado analizar datos y hacer gráficos de todo tipo).

http://soft.proindependent.com/qtiplot.html .

Para programas de cálculo el tema de aplicaciones web no está muy avanzado. Varios de los

programas anteriores se pueden instalar en servidores de tal forma que un usuario a través de un

navegador pueda tener un acceso limitado a algunas funcionalidades de los programas, pero no hay

páginas web como Editgrid en la que con registrarte tienes acceso al programa y con opciones para

colaborar.
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Ficha 4: Escribir matemáticas

Una cuestión importante, especialmente en una universidad a distancia como la Uned, es cómo

transmitir o escribir matemáticas de tal forma que sea fácilmente legible.

A. Matemáticas manuscritas **. Si se tiene un escáner o cámara digital no es una mala

opción escribir en una hoja lo que se quiere enviar, escanearlo (o hacerle una foto) y el

documento resultante (buenas opciones son PDF y JPG) adjuntarlo a un correo o mensaje.

Se agradece ver, de vez en cuando, letra manuscrita sobre todo si es legible.

B. Matemáticas en formato texto *.

Hay algunas convenciones para escribir fórmulas sencillas.

Símbolo ‘^’ para indicar exponenciación. Ejemplo x^2 equivale a x al cuadrado.

Símbolo ‘_’ para indicar subíndices. Ejemplo x_2 equivale a x sub 2.

Para delimitar exponentes y subíndices se puede utilizar las llaves: { }. Ejemplo, x^{a+b}.

Si tenemos una fracción donde el numerador y/o denominador tienen varios sumando se

pueden utilizar paréntesis y ‘/’. Ejemplo, (x^2+x+1)/(x-1)

Hay que evitar matrices, integrales, o fórmulas donde haya muchos subíndices y/o

exponentes, y más aún si hay subíndices de subíndices y subíndices en exponentes, etc. De

lo contrario las fórmulas se convierten en ilegibles.

C. Matemáticas en HTML **.
Cuando uno escribe en los foros de los cursos virtuales de la Uned (y en general en cualquier foro o
blog) puede utilizar etiquetas HTML, esto permite un poco más de juego y poder escribir fórmulas
sencillas. Para saber más sobre el lenguaje de HTML ir a http://es.wikipedia.org/wiki/Html .

Para empezar subíndices y superíndices:
x<sup>2</sup> ≡ x2

x<sub>2</sub> ≡ x2

Todas las letras griegas:
&alpha; ≡ α
&beta; ≡ β
...

Y otros símbolos que son útiles:
&infin; ≡ ∞
&rarr; ≡  → 

&rArr; ≡ ⇒
&radic;2 ≡ √2

Muchos símbolos tienen su abreviatura en HTML, pera ver una lista buscar en Google “HTML
symbols”. Por ejemplo: http://www.cs.tut.fi/~jkorpela/HTML/guide/entities.html

Hay que evitar los símbolos de mayor > y menor < porque estos símbolos están reservados para
abrir y cerrar las etiqueta de HTML y si se utilizan los resultados son imprevisibles. La solución
para que aparezcan bien es escribir:

&lt; ≡ < (la abreviación lt viene de “less than")
&gt; ≡ > (la abreviación gt viene de “greater than")

y ya de paso...
&le; ≡ ≤ (la abreviación le viene de “less or equal")
&ge; ≡ ≥ (la abreviación lt viene de “greater or equal")
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D. Matemáticas con Microsoft Word ***.

Word tiene un editor propio para insertar ecuaciones. En Office 2003 hay que ir a insertar

objeto, y en la lista de objetos está Microsoft Equation.

En Office 2007 hay otro editor de ecuaciones muy mejorado, pero no es compatible con

Office 2003. Se accede a él yendo a la pestaña insertar y después apretando el botón

Ecuación. Si se escribe un documento dónde no haya muchas fórmulas ni muy

complicadas, el Word y su editor de ecuaciones es adecuado especialmente el del Office

2007. Mención especial merece MathType, que es un potente editor de ecuaciones que

puede funcionar como un programa independiente o incrustado en programas como

Microsoft Word y PowerPoint.

E. Matemáticas con LaTeX ****.

Toda la siguiente sección tratará de LaTeX por requerir una explicación extensa.
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Ficha 5: LaTeX ****

Sin lugar a dudas LaTeX es el editor de documentos científicos más potente y con mejor

presentación final (los documentos que produce tienen un aspecto totalmente profesional), sin

embargo aprender a utilizarlo requiere bastante esfuerzo. Para el que sabe lo que son las etiquetas

HTML, se puede decir que LaTeX es para escribir fórmulas matemáticas lo que HTML es para las

páginas web. LaTeX consiste en un lenguaje de códigos especialmente apropiado para textos

científicos. Estos códigos se deben escribir en un editor de textos, después hay que ejecutar un

programa para compilar o transformar estos códigos en un PDF, DVI o PostScript (los 3 formatos

que LaTeX maneja).

A continuación ponemos un ejemplo del código LaTeX (a la izquierda) para crear un documento

sencillo (a la derecha). Cualquier documento LaTeX debe empezar con un preámbulo donde se

define el formato general del documento, se cargan algunos paquetes y se define el título. Después

viene el cuerpo del documento (que es dónde se escribe el texto) que empieza con

\begin{document} y termina con \end{document}.

LaTeX funciona con la filosofía de que la parte de redactar un texto y la parte de dar formato a un

texto deberían estar totalmente separadas (porque son dos procesos mentales que no tienen nada

que ver). Por eso se escribe primero el texto sin ver cómo va a ser el aspecto final (imagen

izquierda), y al final se compila para ver el resultado final (imagen derecha). Cuándo uno escribe

un texto en un procesador de textos normal tipo Microsoft Word, y de repente hay algo del

formateo que no le gusta (la sangría del texto o el tamaño de la letra o el énfasis de una palabra,

etc.) se para y lo arregla inmediatamente, con lo cual se produce una interrupción en la redacción

del texto que puede resultar costosa.

Veamos los programas recomendados:

1) WinEdt + MiKTeX + GSView + Ghostscript + Adobe Reader (Windows). El sistema

recomendado para Windows consiste en estos 5 programas, que hay que instalar por

separado y en orden inverso al que escrito. Se recomienda no cambiar las rutas donde se
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instalan los programas, de lo contrario WinEdt puede que no encuentre al resto de

programas.

a. Instalar el Adobe Reader es sencillo, ir a http://www.adobe.com/es/ y hacer click

en el botón , descargar el fichero e instalar. Es conveniente

tener una versión relativamente actualizada, digamos que superior a la 7.0.

b. Para Instalar GPL Ghostscript hay que ir a la página

http://pages.cs.wisc.edu/~ghost/ y pinchar en la última versión (actualmente “

GPL Ghostscript 8.62 released 2008-02-29 “). En la nueva página, hay un

apartado titulado Microsoft Windows, y dentro están los links a los ficheros de

instalación para Windows 32-bits gs862w32.exe y para Windows 64-bits

gs862w64.exe (básicamente escoger esta opción si se tiene Windows Vista en un

ordenador reciente). Cuando haya acabado la descarga hay que pinchar sobre el

fichero, puede que haya una ventana que alerte de que es un fichero ejecutable

(elegir aceptar) y otra de que no se puede comprobar el fabricante (dar ejecutar),

estas son ventanas que Windows pone para que no ejecutemos software

malintencionado, que no es el caso. Después dar a Setup -> Install y en un

momento se instala.

c. Para Instalar GSView hay que ir a la página http://pages.cs.wisc.edu/~ghost/ y

pinchar en la última versión (actualmente “ GSview 4.9 released 2007-11-19 “).

En la nueva página están los links a los ficheros de instalación para Windows 32-

bits gsv49w32.exe y para Windows 64-bits gsv49w64.exe. Cuando haya acabado

la descarga hay que pinchar sobre el fichero, puede que haya una ventana que

alerte de que es un fichero ejecutable (elegir aceptar) y otra de que no se puede

comprobar el fabricante (elegir ejecutar). Después dar a Setup -> Espaniol ->

Siguiente -> Siguiente… varias veces y en un momento se instala.

d. Para instalar MiKTeX hay que ir a la página http://miktex.org/ y pinchar en el

vínculo que hay a la izquierda en el apartado Download (actualmente pone

“MiKTeX 2.7“). Después hay que pinchar en el botón Download del Basic

MiKTeX . Cuando haya acabado la descarga hay que

pinchar sobre el fichero, puede que haya una ventana que alerte de que no se

puede comprobar el fabricante (elegir ejecutar). Después hay que aceptar las

condiciones de copia y Siguiente -> Siguiente -> Siguiente -> Siguiente -> Start y

se instalará en unos pocos minutos, para acabar hay que elegir Siguiente -> Close.

e. Para instalar WinEdt (los anteriores programas son gratuitos, éste es shareware, lo

cual quiere decir que se puede utilizar sin pagar pero da la lata para que pagues a

base de mensajes) hay que ir a la página http://winedt.com/ y pinchar en el vínculo

que hay a la izquierda titulado Downloads. En la nueva página hay que ir al

apartado “CTAN …” y pinchar en el link con el fichero ejecutable de la última

versión oficial (actualemente “WinEdt 5.5 [Build: 20071003] (official release)”)

. Cuando haya acabado la descarga hay que pinchar sobre el fichero, puede que

haya una ventana que alerte de que es un fichero ejecutable (elegir aceptar) y otra



Roberto Canogar McKenzie Curso 0 Matemáticas

18

de que no se puede comprobar el fabricante (elegir ejecutar). Después Next ->

Pinchar en “I accept the agreement” -> Next -> Next -> Next -> Next -> Install y

en un momento se instala, después dirá que ha acabado y al darle al botón Finish

se abre directamente WinEdt. La primera vez que se ejecuta se abre una ventana

titulada “WinEdt Configuration Wizard”, aquí hay que ir a la penstaña “File

Associations” y en esta pestaña a la derecha en el apartado “Current User”, hay

que apretar el botón “Modify file type associations…”, y entonces sale otra

ventana con las extensiones de ficheros que se abrirán con WinEdt; elegimos

Aceptar y se cierra la ventana de las asociaciones. Después se puede apretar OK

para cerrar la ventana “WinEdt Configuration Wizard”.

Como ejemplo para empezar, se puede pinchar en el botón con la hoja en blaco arriba

a la izquierda (o ir a File -> New) y escribir (ésta es una plantilla sencilla, para

documentos más complicados hacen falta plantillas un poco más extensas):

\documentclass[12pt]{article}

\usepackage[spanish]{babel}

\title{el título que se le quiera dar al documento}

\begin{document}

\maketitle

…el texto que se quiera poner en el documento…

\end{document}

Después hay que guardar el fichero pinchado en el botón justo debajo de la hoja en blanco

que es un diskette (o ir a File -> Save) y elegir un nombre que acabe con la extensión

“.tex” que es la extensión que tienen los ficheros de LaTeX. Por último, si damos al botón

con el León se abrirá un programa que se llama Yap para mostrarnos el resultado

compilado de nuestros códigos de LaTeX. Yap visualiza ficheros con extensión DVI que

es el formato estándar que Latex crea. Si damos a este otro León entonces se abre el

Adobe Reader para mostrarnos el resultado de compilar directamente a PDF.

Para terminar es muy recomendable configurar tres cosas de WinEdt:

 Activar Inverse Search en el Yap (el visualizador de DVI):
Ir a "View" -> "Options" -> "Inverse DVI Search" -> seleccionar "WinEdt (auto-
detect)" -> Aceptar.
Esta opción permite hacer doble click en un lugar determinado del DVI para que
se abra automáticamente el WinEdt en el lugar indicado. Es muy útil.

 Para no preocuparse de los acentos:
En Winedt ir a "Options" -> "Settings" -> "Translations" -> en TeX\_Read y en
TeX\_Write marcar el tick "Enabled" y después OK para aplicar los cambios.

En LaTeX los acentos, eñes y algunos caracteres especiales hay que escribirlos de
una forma especial, por ejemplo "\'{a}" para la "a" acentuada. El TeX\_Read
marcado hace que al leer un archivo LaTeX se muestre "á" en lugar de "\'{a}". El
TeX\_Write marcado hace que al guardar un archivo LaTeX se guarde "\'{a}" en
lugar de "á".

 Para poder utilizar diccionarios en Inglés y Español (por defecto sólo hay uno
en Inglés):
Primero tenemos que descargar el archivo "ES.zip" desde http://tug.ctan.org/tex-
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archive/systems/win32/winedt/dict/es.zip , descomprimirlo y el archivo “es.dic”
(el otro fichero “es.txt” es simplemente una descripción del diccionario) copiarlo
en la carpeta "C:\Archivos de programa\WinEdt\Dict\ES", la carpeta "ES" hay que
crearla nueva (donde estamos suponiendo que "C:\Archivos de programa\WinEdt"
es la carpeta donde se ha instalado WinEdt).

Después hay que descargar el archivo "Dict-US-ES.dat" desde el enlace
http://portal.uned.es/pls/portal/url/ITEM/52C9942C1B7B451FE040660A3470463
C al Escritorio (por ejemplo). A continuación en WinEdt ir a "Options" ->

"Dictionary" -> pulsar el botón (es el último y lleva el nombre "Load From...")
-> cargar el archivo "Dict-US-ES.dat" y por último OK para confirmar los
cambios. Con esto se configura el menú de los diccionarios de cierta forma.

El resultado es que por defecto se carga el diccionario en Inglés (un Inglés
americano estricto). Si queremos deshabilitar el diccionario de Inglés y activar el
de Español para un documento concreto, hay que hacer lo siguiente: presionar el

botón (que está en el panel principal y lleva el nombre de "Document
Settings..."), en el recuadro "Document Mode" aparecerá "TeX" (si estamos
editando otro tipo de documento aparecerá otro modo: por ejemplo "HTML",
"DATA", "ASCII"), entonces hay que cambiarlo por "TeX:ES" y por último
presionar "OK". Lo que hemos hecho es cambiar el modo del fichero que
tengamos abierto de "TeX" a "TeX:ES", (o siendo más preciso, lo hemos
cambiado a modo "TeX" y sub-modo "ES"). Al guardar un archivo, el modo y
sub-modo también se guardan, así la próxima vez que abramos el fichero el
diccionario Español estará habilitado y el Inglés deshabilitado.

2) MacTeX (Mac). Se instala muy fácilmente, nada que ver con lo descrito para Windows, el
único problema es que la distribución es un fichero de 700 megas. Para descargarlo ir a
http://www.tug.org/mactex/ .

3) Emacs (Linux). Emacs el editor más potente de Linux y ya está instalado, además LaTeX
ya está incluido de serie en Linux.

4) Monkeytex.com (aplicación web, por tanto cualquier sistema operativo). Es gratuito, pero
no tiene muchas opciones. Ideal para probar LaTeX ya que no requiere ninguna
instalación. Además el fichero LaTeX y los PDF creados tienen su propia URL, por tanto
también es ideal para mostrar y para colaborar con otras personas.

Como documentación para aprender a utilizar los códigos de LaTeX, recomiendo:

El PDF gratuito “La introducción no-tan-corta a LaTeX 2E” es un fichero muy recomendable y

además está en español: http://ftp.gui.uva.es/sites/ctan.org/info/lshort/spanish/lshort.pdf.

Preguntas típicas de LaTeX en Español: http://elena.aut.ac.nz/ctan/help/es-tex-faq/FAQ-

CervanTeX.html y http://www.cervantex.es/

Una selección de capítulos del libro “More Math into LaTeX” de George Grätzer (ISBN-13: 978-387-

32289-6) que sirve como una excelente introducción: http://winedt.com/doc/Short_Course.pdf . El

libro completo se suele considerar el mejor libro sobre LaTeX.
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4. Prueba de Autodiagnóstico

Lea las preguntas planteadas, y si no sabe responderlas, o no está seguro, es aconsejable que

vuelva a releer con más atención la ficha indicada.

1) ¿Qué tipo de calculadoras se admiten regularmente en exámenes de la UNED?

(Ficha 1)

2) ¿Qué programa de licencia pública general GNU tiene funcionalidades parecidas a

Microsoft Office y además funciona en Linux?

(Ficha 2)

3) ¿Cuáles son las ventajas principales de una aplicación web comparada con una aplicación

normal?

(Ficha 2)

4) ¿Cómo se introducen referencias absolutas en una fórmula de una hoja de cálculo?

(Ficha 2)

5) ¿Qué cálculo puede hacer un programa de cálculo simbólico que no puede hacer una

calculadora?

(Ficha 3)

6) ¿Podría nombrar 3 programas de cálculo simbólico?

(Ficha 3)

7) ¿Cuál es la forma estándar de escribir ‘x al cuadrado’ en formato texto?

(Ficha 4)

8) ¿Sabe cómo escribir fórmulas en Microsoft Word 2003 y 2007?

(Ficha 4)

9) ¿Existe alguna aplicación web para LaTeX?

(Ficha 5)

10) ¿Cuál es la diferencia entre un procesador de textos normal, tipo Microsoft Word, y

LaTeX?

(Ficha 5)
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